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PurposePurpose

To familiarize participants with reliable online health 
information from the National Library of Medicine and 
other reputable HIV/AIDS-related resources

To empower participants with the skills and knowledge to 
better serve their clients, colleagues, and communities 
through the use of online HIV/AIDS-related resources
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ObjectivesObjectives

After completing this class, participants will be able to

Identify and evaluate quality, accurate, and authoritative 
online resources pertaining to HIV/AIDS and related 
medical conditions

Demonstrate the ability to perform strategic search 
techniques in order to find HIV/AIDS treatment and 
prevention information

Apply the skills and knowledge obtained in this course to 
their organization’s culture
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The National Library of MedicineThe National Library of Medicine

The world’s largest biomedical library

Part of the National Institutes of Health
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For the PublicFor the Public
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NLM ResourcesNLM Resources

NLM resources covered in this class:

AIDSinfo®

ClinicalTrials.gov®

MEDLINE®/PubMed®

MedlinePlus®

NLM Gateway

DIRLINE

88

NLM Database AssistanceNLM Database Assistance

Training Manuals
– PubMed, NLM Gateway, ClinicalTrials.gov
– http://www.nlm.nih.gov/pubs/web_based.html

PubMed Help/FAQ and Tutorial   
– http://pubmed.gov (see links on sidebar) 

NLM Fact Sheets
– http://www.nlm.nih.gov/pubs/factsheets/factsheets.html
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The National Network of Libraries The National Network of Libraries 
of Medicineof Medicine

http://nnlm.gov 99
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Basic Internet SkillsBasic Internet Skills
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What is the Internet? The World What is the Internet? The World 
Wide Web?Wide Web?

The Internet and the World Wide Web (Web) are not the 
same thing

– The Internet is a worldwide network of computer networks 
that can all “talk” to each other using languages called 
“protocols”

– The Web is only one portion of the Internet – the best 
known part

The Web is viewed with a graphical interface software 
called a “browser,” such as 

– Microsoft’s Internet Explorer
– Mozilla Firefox
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Uniform Resource LocatorUniform Resource Locator

A URL is made up of
– The “protocol” name (language) http://
– The “server” name nlm.nih.
– The “domain” name gov
– And sometimes also

• A directory name and/or portals
• A file name public.html

http://www.nlm.nih.gov/hinfo.html
http://www.nlm.nih.gov/portals/public.html
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Using the Navigation ToolbarUsing the Navigation Toolbar

Go Back to the previous page or Forward to where you 
just were

Click Stop to stop loading a page

Click Refresh to reload a page

Go Home to your starting page 

66

Using the Navigation ToolbarUsing the Navigation Toolbar

Click Print to print the page you are on, 
but be careful!

– One Web page can be many pages when printed
– Use Print Preview (under the File pull-down menu) to see 

how many pages will be printed
– If the Web page you are viewing has frames, be sure to 

click your cursor in the frame that you want to print

Click Mail to send the page to someone
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Bookmarking Favorite PagesBookmarking Favorite Pages

Go to the page you want to bookmark

Click Favorites and select Add to Favorites…

Organize your bookmarks for easier use
– Click Favorites and select Organize Favorites…
– Click Create Folder

• Type a name for the new folder
– Drag and drop saved bookmarks to any folder

To delete a bookmark you don’t want any more
– Click Favorites, right-click the bookmark you want to delete, and 

select Delete
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Changing Your Home PageChanging Your Home Page

Click the Tools menu and select
Internet Options

In the Internet Options dialog box, type the URL of your 
chosen page (e.g. http://www.nlm.nih.gov), 

Or… Go to the page you want to use as your home page, 
click Tools/Internet Options, 
then click the Use Current 
button below the address
box



EQUAL ACCESS INITIATIVE:
HIV/AIDS Information Resources from the National Library of Medicine

Pub Date:  November 2007
Updated 3-25-2008

Basic Internet Skills
5

99

Look for links of topics of interest to click. Links can be
– A word, a phrase, or a sentence
– A picture or graphic image
– You’ll know it’s a link when the mouse arrow 

pointer turns into a pointing finger 

Look for Frequently Asked Questions (FAQs)

Look for an electronic forum

Exploring a Web SiteExploring a Web Site

1010

Search Directories Search Directories 

Organized by subject

Categorized and indexed (“hand-picked”) by people

For broad, general topic searches 

Examples
– Google Directory at http://www.google.com/dirhp
– Yahoo Directory at http://www.yahoo.com > Directory
– Open Directory Project at http://dmoz.org
– LookSmart Directory at http://looksmart.com/x02
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Search EnginesSearch Engines

Index documents and match text to key words requested 
by the user

Two types
– Searches a large portion of pages on the Web
– Searches within topics, regions, or sites

Some search engines are also Web portals, including 
Google, Yahoo!, and Ask.

http://www.google.com http://www.yahoo.com http://www.ask.com
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Your Search StrategyYour Search Strategy

PLAN!
– What are you looking for? 
– Is the Web the best place to find the information?

ACT!
– Know which search tool(s) to use

REVIEW!
– Did the information you find answer your question?
– Do you need to redefine, narrow, or expand your topic?
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How to Construct a SearchHow to Construct a Search

Formulate the search question 
– What information is available about treatment options for 

children with HIV?

Identify the important concepts within the question
– Children, HIV, treatment

Identify the search terms to describe those concepts
– Children, HIV, treatment

1414

How to Construct a SearchHow to Construct a Search

Consider synonyms and variations of those terms
– Children, childhood 
– Childhood, juvenile, youth, child, adolescent

Prepare your search logic (Boolean logic)
– (children OR childhood) AND hiv AND treatment 
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Boolean LogicBoolean Logic

Boolean commands:  AND OR NOT
– HIV AND AIDS (finds all search terms)
– Treatment OR Therapy (finds either term or both)
– Tuberculosis NOT Pneumonia (eliminates specified terms)

Nested parentheses
– Common cold AND (vitamin c OR zinc)
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Narrow a SearchNarrow a Search

To narrow a search on apples, you could
– Add more words

• apples macintosh
– Search as a phrase

• “apple pie recipe”
– Exclude words

• apples – macintosh
• apples NOT macintosh
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Broaden a SearchBroaden a Search

To broaden a search on “macintosh apples” – Fiji
– Use a broader term

• apples
– Use fewer words
– Do not search as a phrase
– Do not exclude words
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Printing Web PagesPrinting Web Pages

Different types of files on the Internet

Most common file types
– HTML files – indicated by extension “.html” or “.htm”
– Adobe Acrobat files – indicated by extension “.pdf”

On your Web navigation tool bar, click the print icon – or 
click the File pull-down menu and select Print
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Printing HTML PagesPrinting HTML Pages

HTML pages may not print as seen on screen

Use Print Preview (on the File pull-down menu) to see 
how the page will print and how many pages will be 
printed

If the Web page you are viewing has frames, be sure to 
click your cursor in the frame that you want to print

2020

Saving Web PagesSaving Web Pages

On the navigation tool bar, click the File pull-down menu 
and select Save As

A window will pop up to 
allow you to select the 
folder in which you want 
to save the document

Select a folder and click
the Save button
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About Adobe PDF PagesAbout Adobe PDF Pages

Adobe PDF (PDF) is a universal file format
– Standard for worldwide electronic document distribution
– Created by Adobe Systems, Inc.

PDF files will print as they appear on screen

PDF displays document information intact
– Page numbering
– Illustrations

Free program to read PDF files is called Adobe Reader

2222

Adobe Reader Adobe Reader 

http://www.adobe.com/products/acrobat/readstep2.htmlhttp://www.adobe.com/products/acrobat/readstep2.html
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Printing Adobe PDF PagesPrinting Adobe PDF Pages
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CautionCaution

Computer viruses are transmitted through e-mail and can 
be harmful to your computer!

– Do not open a suspicious e-mail message
– Immediately delete it and then empty your Deleted Items 

folder
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Finding Quality Health InformationFinding Quality Health Information
on the Interneton the Internet

Where to Start and Where to Start and 
How to Evaluate the Information you FindHow to Evaluate the Information you Find
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Why the Internet?Why the Internet?

Abundance of FREE information
– Medical journals/databases
– Clinical trials
– Treatment information
– Prescription drugs

24-hour-per-day availability

Current awareness

Connecting with others with similar medical 
problems

Anonymity/privacy



EQUAL ACCESS INITIATIVE:
HIV/AIDS Information Resources from the National Library of Medicine

Pub Date:  November 2007
Updated 3-25-2008

Finding Quality Information on the Internet
2

33

Evaluating Internet ResourcesEvaluating Internet Resources

Be careful: Information on the Internet may be unreliable

Be savvy: Evaluate the information you find

44

Savvy Health SurfingSavvy Health Surfing

Authority

Accuracy

Coverage

Currency

Objectivity

Design Features
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Cases of Inaccurate Web Cases of Inaccurate Web 
InformationInformation

Johns Hopkins University’s and C. Everett Koop’s 
Web sites were slow to add information on new hepatitis 
treatments

Reports of anthrax exposure have resulted in fraudulent 
Web sites selling products to protect 
against biological threats
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Cases of Inaccurate Web Cases of Inaccurate Web 
InformationInformation

Home HIV tests
– Many home HIV test kits sold over the Internet 

supply inaccurate results according to the 
Federal Trade Commission

– Correct information: Only one home test is 
reliable, as per the Food and Drug 
Administration (FDA)

• Home Access Express HIV-I Test System
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CautionCaution

Avoid Web sites that:

Advertise a "new cure" for a serious disorder or 
a quick cure-all for a wide range of ailments

Use impressive-sounding terminology to 
disguise a lack of good science or those that 
claim the government, the medical profession, 
or research scientists have conspired to 
suppress a product

Include undocumented case histories claiming "amazing" 
results
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Evaluating Internet ResourcesEvaluating Internet Resources

Use your best judgment and these criteria to 
evaluate information on the Internet

Consult your health care professional before 
making any treatment decisions
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AIDSAIDSinfoinfo

A U.S. Department of Health and Human Services 
(DHHS) project sponsored by the following U.S. Federal 
government agencies: 

– National Institutes of Health/National Library of Medicine
– Centers for Medicaid and Medicare Services
– Health Resources and Services Administration
– Centers for Disease Control and Prevention
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AIDSAIDSinfoinfo

The latest federally approved information on HIV/AIDS 
– Clinical research 
– Treatment and prevention
– Medical practice guidelines

Audience
– HIV/AIDS patients, their families and friends, 

health care providers and researchers 

44http://http://aids.nlm.nih.govaids.nlm.nih.gov
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ClinicalTrials.govClinicalTrials.gov

Developed by the U.S. National Institutes of Health (NIH), 
through its National Library of Medicine (NLM) in 
collaboration with NIH Institutes and the Food and Drug 
Administration (FDA)

Easy access to information on clinical trials for a wide 
range of serious or life-threatening diseases and 
conditions

Language intended to be suitable for general public

Studies included conducted in 50 states and more than 
154 countries
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BenefitsBenefits

Locate an open clinical trial for a specific ailment

Find contact information for the study

Determine what treatments for a specific ailment are 
currently being studied

Confidential 
– No registration or personal identification is required

44

Basic SearchBasic Search

Type your search term(s) into the query box
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MEDLINE/PubMedMEDLINE/PubMed

PubMed is a search tool for accessing literature citations 
from NLM’s premiere bibliographic database, MEDLINE, 
and other databases

Special Features
– Updated daily
– Clinical query filter
– Special queries directory
– Related articles
– Links to other NLM-related resources
– Links to full-text journals at Web sites of participating 

publishers
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PubMed SearchingPubMed Searching

Key words
– Automatically matched to MeSH, journal titles, phrase list, 

and author index
– Not case sensitive

Phrases (“heart attack”)
– Phrases in quotes will not be matched to MeSH, journal 

titles, phrase list, and author index

Author’s name format for searching (smith ja)

Full name may be used for citations from 2002 forward

44

PubMed SearchingPubMed Searching

Boolean commands:  AND, OR, and NOT
– hiv AND aids finds all search terms
– treatment OR therapy finds either term or both
– chicken pox NOT shingles eliminates specified terms

Stop words
– Frequently used words such as: for, this, no

Truncation
– Finds all words beginning with a given root word or text 

string
– Place an asterisk (*) at the end of the term (e.g., infect*)
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MedlinePlusMedlinePlus

User-friendly source

Health information for patients and the public

Credible sources

Easy-to-read language

Links to MEDLINE/PubMed searches
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The NIH MedlinePlus MagazineThe NIH MedlinePlus Magazine

You can
– Receive a free subscription
– Download past issues
– Order 25 or more copies for 

only $1 each

Click NIH MedlinePlus Magazine
in the bottom right corner of the 
MedlinePlus home page

44

The MedlinePlus ListservThe MedlinePlus Listserv

An e-mail announcement list with links to new topics and 
sites containing consumer health information

Click E-mail Updates and RSS
in the bottom right corner of the 
MedlinePlus home page
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Search Results Search Results -- CategoriesCategories
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NLM GatewayNLM Gateway

“One-stop shopping”
– One interface to search many NLM bibliographic, 

consumer and specialty resources

Potential NLM Gateway users
– People who are not familiar with NLM’s resources
– People who want search multiple databases at once
– People who want to search resources that are available 

only in the NLM Gateway
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DIRLINEDIRLINE

Contains over 8,000 records
– Includes national health/biomedical information resources 

and groups with other special interests

Information includes
– Names
– Addresses
– Telephone numbers
– Interests
– Activities
– Services
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Using DIRLINEUsing DIRLINE

You may search using
– Subject words or MeSH headings
– Name, acronym, or location of an organization

You may select
– Only organizations with toll-free numbers
– Only organizations with services for the hearing impaired

You may Browse the Index for text words or key 
words/MeSH headings

You may BROWSE THE A-Z List of Health Organizations

44

Organization NameOrganization Name

Enter one or more significant words from the name of an 
organization

Example

Entering the search terms: minority aids council

. . . and clicking the box beside 
“Organization name or acronym,”

. . . retrieves the record for: National Minority AIDS Council
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